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INTRODUCTION

This manual is for use with the 9/05/1996 version of Super-MICAR. Please check the date on
the About Super-MICAR screen by pressing {ALT-F1} from the main screen of Super-
MICAR.

What This Manual Is

This is the Super-MICAR User’s Guide. Super-MICAR is an automated cause-of-death
data processing system designed for data entry, editing, and processing of medical
information reported on a death certificate in the United States. Very little training is
required to use Super-MICAR and the on-screen prompts allow data to be entered with
ease.

In the event that the software needs to be ordered, there are questions concerning the
software, or if there are questions about data entry, please contact NCHS at one of the
following numbers:

Software Helpline: 1-800-642-8908

Nosology Helpline: 1-800-235-1830

Super-MICAR is one part of the National Center for Health Statistic's Mortality Medical
Data System. NCHS began developing the system in 1967 to automate the entry,
classification, and retrieval of cause-of-death information reported on death certificates.
Mortality medical data is processed through four basic programs: Super-MICAR,
MICAR , ACME , and TRANSAX .1 2 3

 Super-MICAR Automates MICAR data entry and medical cause-of-death data
processing, including reporting procedures, full-screen data entry
and editing, query letter generation, and additional information
processing. Super-MICAR is designed to automatically encode
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medical cause-of-death data into numeric entity reference numbers
in accordance with the rules expressed in Part 2g of the Vital
Statistics Instruction Manual (VSIM) series. Super-MICAR output
is used by later programs to classify causes of death to their
International Classification of Death (ICD) codes. Super-MICAR
only runs on personal computers.

 MICAR Automates the multiple cause coding rules (see Parts 2b and 2e of
the VSIM series) and assigns ICD codes to each entity.

 ACME Applies World Health Organization (WHO) rules to the ICD codes
determined by MICAR and selects an underlying cause of death
(see Part 2a and 2c of the VSIM series). ACME is available on both
the mainframe and the personal computer. On the PC, ACME and
TRANSAX are distributed as a single product.

 TRANSAX Facilitates the tabulation and use of multiple cause-of-death data.
Through the application of the ICD linkage and modification rules,
TRANSAX translates the axis of classification from an entity to a
record base. TRANSAX is available on both the mainframe and the
personal computer.

The only other manual specifically associated with this one is the Super-MICAR System
Manager's Manual. The System Manager's Manual contains information on the
installation and maintenance of the Super-MICAR software, as well as some utilities that
may need to be used.

Who This Manual Is For

This manual is intended for data entry and data processing personnel. It contains
instructions on using Super-MICAR to enter cause-of-death information and to process
that information, including reject processing. Only those sections of Super-MICAR that
deal with data entry and processing operations are addressed in this manual. It is
organized on the assumption that the user has little or no familiarity with Super-MICAR.
Therefore, the subjects in this manual are arranged so the user receives all of the
instructions necessary to perform a given task at once.
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Changes in This Manual

The Super-MICAR User’s Guide has been updated to match changes that have been made
in the software. These changes are listed below:

Minor Corrections
Various minor corrections have been made to this manual so that it accurately matches
what is in the software. Also, the helpline numbers have been added to the introduction to
aid in customer support.

Retitled
The most basic change is that this manual has been renamed. Originally, it was called the
Super-MICAR Data Processing Manual. In order to standardize all the manuals associated
with Super-MICAR, PC-MICAR 100/200, and ACME/TRANSAX, this book has been
retitled the Super-MICAR User’s Guide.

Screen Captures
Several problems were reported with the screen captures contained in this manual. Most of
these were due to differences in types of printers. The screen captures have been
reformatted so that they should appear clean and straight.

Changes from the 1995 Version

The 1996 version of Super-MICAR software includes numerous changes from the 1995
and other previous versions. Many of the changes are easily apparent, and others might go
almost unnoticed. This section outlines the differences, so that you can quickly familiarize
yourself with them. 

Moved Menu Items
Several of the Functions in the drop-down menus have been moved around. Table 2 (pg.
12) has a complete listing of all menus and Functions.

Exit to DOS
An Exit to DOS Function has been added under the File menu. This allows the user to
immediately access a DOS subsession and enter DOS commands.

Reporting Area
The Reporting Area field that appeared on the batch information screen has been removed.
This data is no longer collected.
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Coder Status
At the request of several states, the values for this  field have been expanded to allow
entry of single-digit numbers 0 through 9. 

Place of Injury
Super-MICAR will now accept full text and generate the Place of Injury code from text
entered by the user.

Activity Code
A new field, Activity Code, has been added. This new field collects information about the
decedent's activity at the time of death. A pop-up menu of options is available by entering
a question mark in the field. For a complete list of the activity codes, refer to the 1996
version of the 2g manual.

Backup/Remove Option
This new option backs up the open file to a floppy disk, then, if the backup is successful,
deletes the file from your hard drive.

Backup and MICAR 100 Export Paths
In Super-MICAR 1996, it is possible to set up a subdirectory on the computer’s hard drive
or on a network drive in which to store data backups and exported MICAR 100 input files.
These options facilitate putting important data on network drives where it can be easily
protected by the local network administrator. These paths should be set by the system
manager. By default, these files are stored in the <DATA> directory.

Changes in the 1996 Version

All of the changes in the 1996 version of the Super-MICAR software have been bug
corrections. These are detailed in the  Super-MICAR System Manager's Manual.
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OVERVIEW

Basic Steps

Super-MICAR is designed to allow both data entry and data processing through the menu
system. When collecting and processing data through Super-MICAR, certain steps should
be followed in order to guarantee the best results with the least wasted time. What follows
is a general outline of the MINIMUM data entry and processing steps for Super-MICAR.
Super-MICAR contains several utilities and reports that are helpful in validating data and
keeping track of data entry and processing. Utilities and reports are described in the next
section, with indications of where they would be most useful. 

Note that the relevant sections of this manual are listed next to each step. A flow chart
depicting the Super-MICAR process has been provided at the end of this section for
convenience. 

1. Start Super-MICAR (STARTING Super-MICAR, pg. 15).

2. Open a certificate file (Creating a New Certificate File, pg. 16 or Opening an
Existing File, pg. 19). This step opens a file so that data can be entered and
processed. You can either open an existing file or create a new file. With very few
exceptions, every function that Super-MICAR can perform requires that a file be
opened before the function can be preformed.

3. Edit the certificate file header information as needed (Creating a New Certificate
File, pg. 16). The header information contains constant data that is the same for
every record in the certificate file, such as the data year and the state code.

4. Add certificates to the database (ENTERING AND SAVING CERTIFICATE
DATA, pg. 21). This is the main data entry process. Data can also be read into
Super-MICAR from properly-formatted files. Information in importing and
exporting data is contained in the Super-MICAR System Manager's Manual.

5. Mark misspellings/illegible entries for correction (Marking Misspellings/
Illegibles, pg. 38). This function checks all of the records in the file for words that
Super-MICAR does not recognize and/or for the word ILLEGIBLE. (When a data
entry operator cannot read a word on a death certificate, typing the word
ILLEGIBLE will cause this function to mark the record.) Misspelling and illegibles
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must be marked before they can be corrected, and the process of marking and
correcting these words should be done after data entry is complete and before
processing the file.

6. Correct marked misspellings/illegibles (Correcting Misspellings/Illegibles, pg.
39). This function allows the user to go directly to those records that were marked
as having misspelled or illegible words and correct them. This function can only be
used after misspellings and illegibles have been marked, and should be used before
processing the file.

7. Process the certificate file (PROCESSING A CERTIFICATE FILE, pg. 42).
When a file is processed, Super-MICAR assigns entity reference numbers (ERNs)
to the medical causes of death that were listed in the certificate file. Two steps are
required to completely process a file:

A. Process the entire file (Processing Records, pg. 43). This process attempts to
assign entity reference numbers (ERNs) to all of the medical causes of death
for each record in the open certificate file. This process is done wholly by
Super-MICAR, requiring no input from the user. (This process can also be
performed as a batch process, without going through the menu system. See the
section BATCH PROCESSING FROM THE COMMAND LINE in the
Super-MICAR System Manager's Manual for more information on batch record
processing.)

B. Process the rejects (Processing Rejects, pg. 44). Reject processing requires a
trained MICAR coder. Under reject processing, Super-MICAR displays any
records that were rejected by the Processing Records function. A trained
MICAR coder can examine the record and make whatever changes are
necessary to allow the record to be coded. In order to preserve the original data,
modifications can be made on the Additional Information Screen (Editing
Additional Information, pg. 30).

C. Process Additional Information (Processing Additional Information, pg. 48).

8. Use the editing functions to edit any certificates that were rejected or had other
problems during processing (EDITING FUNCTIONS, pg. 56). The Edit menu
contains several utilities for use in editing the certificates.

9. Generate MICAR100 file (GENERATING A MICAR100 FILE, pg. 51). This
file is used by other MICAR software to continue the process of encoding cause-
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of-death data. Note: Data files that will be processed by the 1996 versions of PC-
MICAR100/200 do not require this step.

10. Create a backup for shipment to NCHS (Creating Backups for NCHS, pg. 54).
This function creates a file that can be shipped to NCHS. The file contains all of
the data collected by Super-MICAR, plus the MICAR100 file generated in the
previous step.

11. Close the certificates file (CLOSING A FILE, pg. 55).

12. If there are other certificate files to process, repeat steps 2 through 7.

13. If there are no more files to process, exit Super-MICAR and return to DOS
(EXITING Super-MICAR, pg. 70).

Extra Utilities

Below are listed additional functions that Super-MICAR can perform. Most of these
utilities can be used at any time with Super-MICAR. Most will require that a certificate
file be open. See the individual description of each utility for more details. Please note that
there are more utilities described in the Super-MICAR System Manager's Guide.

1. Browse through and edit the certificates in a file (Browsing Through the
Certificates, pg. 58). This function allows the user to edit information in the
certificate database, which may be necessary at any time.

2. Find a specific certificate number/record in a file (Finding a Record, pg. 60). This
function is available only when browsing through the certificates and allows the
user to display a particular record by specifying its certificate number.

5. Delete a certificate while editing (Deleting Certificates While Editing a
Certificate File, pg. 64). This function allows the user to remove a record from the
certificate file.

6. Delete several certificates at once (Deleting Several Certificates at Once, pg. 65).
This function allows the user to remove a block of several records from the
certificate file. Use this option if an error has occurred and several certificates have
been entered into the wrong file.
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7. Generate a sequence check (Generating a Sequence Check, pg. 66). This function
generates a report that checks the sequence of the certificate numbers in the file. It
is useful in determining if all of the records that should be in the file have been
entered, if unwanted records have been entered, or if records have been entered
with an incorrect certificate number. This function can be used at any time, but is
most useful between data entry and processing to determine if the file is complete.

8. Print a list of errors detected during last processing (Printing an Error Listing,
pg. 68). This function prints a report listing all of the certificates that were not
completely processed by Super-MICAR. This report may be useful to the person
who will perform reject coding.

9. Print all or selected certificates for review. See Printing All the Certificates (pg.
68) and/or Printing a Single Certificate (pg. 69).

10. Perform a daily backup. (Backing Up All the Files, pg. 53). This function creates
a backup copy of the open certificate file either on your system's fixed drive or on a
floppy. Backing up data is the only protection available against losing data due to a
failed computer system. It is a good idea to back up the certificate file at the end of
every day.

There are more Menu Options and Functions available in Super-MICAR than will be used
by data entry personnel. These other Menu Options and Functions will be used by the
system manager. The instructions for them are contained in the Super-MICAR System
Manager's Manual.
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THE MENU SYSTEM

Quick List of Menu Options

TABLE 1: Super-MICAR Menu Options

Key Combination        Menu Option Accessed   

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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Super-MICAR Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File
{SHIFT-F7} Export to ASCII File
{SHIFT-F8} Import from ASCII File

Repair File Index
Merge Another File

{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

Set Backup File Path
Set MICAR100 Export Path
DOS Subsession

{ALT-X} Exit Super-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F9} Edit Additional Info
{ALT-O} Edit Industry/Occupation
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{ALT-U} Undo Changes

Process
Mark Misspellings/Illegibles
Correct Misspellings/Illegibles
Process All Records
Process Rejects
Process Additional Info
Generate MICAR100 File

{F6} Show Processed Output
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Reports
Sequence Check
Generate QC Database
Print Error Listing
Print All Certificates
Generate Query Letters

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove

Help
{F1} View Help File
{ALT-F1} About Super-MICAR

Using the Super-MICAR Menu System

Super-MICAR functions are available through a drop-down menu system. The menu
system allows the user to select functions to perform and to move from task to task
quickly and easily. Unlike the menu lists available through other types of software, Super-
MICAR uses a menu system that allows options to be selected from the menu even when
another function is active. This allows users to select Functions more quickly, without
having to exit their way 'back up the tree' before they can select another function.

There are two ways to access the menu: 

ALT-X: Simultaneously pressing the {ALT} key and the highlighted letter key of a
main menu item will display the drop-down menu for that item. (The Alt keys
for each menu option are listed in Table 1.) Then use the up and down arrow
keys to highlight an item on the menu. Press {ENTER} to select the option.
Use the left and right arrow keys to open submenus for other main menu
options. Pressing {ESC} from a dropped-down menu closes the menu. Pressing
{ESC} from the main menu will exit Super-MICAR.

Hotkey: Many of the functions in the menus have an associated Hotkey. The Hotkey
assignments are shown on the drop-down menus and are listed in Table 2.
Pressing a Hotkey will immediately access the associated function. (For
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Super-MICAR 1996: TEST1.DBF
File Edit Process Reports Backup Help

+))))))))))))))))))))))))))))))))))))))))))))))),
* Edit/Browse Header Info               *
* Add Certificates                  F3  *
* Edit/Browse Certificates          F4  *
* Edit Additional Info              F9  *
* Edit Industry/Occupation       ALT-O  *
* Delete Records                    F8  *
* Find a Record                     F5  *
* Print a Record                    F7  *
* Undo Changes                    ALT-U *
.)))))))))))))))))))))))))))))))))))))))))))))))-

F1-Help 2:58pm

Figure 1:  The Edit Menu Option and its Functions.

example, pressing {F2} will select the Open Existing File Function.) Hotkeys
are the fastest, easiest way to move around Super-MICAR. As users become
familiar with Super-MICAR, they will find the hotkeys easier to use. 

To select a function from a drop-down menu, either use the up and down arrow keys to
highlight an option or press the option's selection letter. The selection letter is displayed in
red (on color monitors) or highlighted (on monochrome monitors). Pressing the selection
letter will move the highlight bar to the selected option. 

Figure 1 gives an example of the Edit Menu Option and its Functions.

Not all functions are available at all times. In order to prevent users from selecting
functions that should not be accessed during a particular process, the menu system will
make certain functions available (active) or unavailable (inactive). On color monitors, the
active options are shown in black while inactive options are shown in gray. On
monochrome monitors, inactive options do not have a highlighted selection letter. When
an option is inactive, it cannot be selected (the highlight bar will skip over that item and
it's Hotkey will not function).
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Super-MICAR 1996: TEST1.DBF
File Edit Process Reports Backup Help

F1-Help 2:58pm

Figure 2:  The Super-MICAR Main Screen.

GETTING STARTED

Starting Super-MICAR

To start Super-MICAR from DOS, use the following steps:

1. Make sure that DOS is currently in the <SUPMICAR> directory.

A. To check to see if the current directory is the <SUPMICAR> directory, type
CD and press {ENTER}. The current directory name will appear on the screen.

B. To change the current directory to the <SUPMICAR> directory, type CD
\SUPMICAR and press {ENTER}.

2. To start Super-MICAR, type SUPMICAR and press {ENTER}.

3. The main menu screen (Figure 2) will be displayed. Refer to the section Using the
Super-MICAR Menu System (pg. 13) for more details on the main screen and the
Menu Bar.

When the main screen appears, Super-MICAR is ready to begin. To start work, see
Creating a New File (pg. 16), or Opening an Existing File (pg. 19). Super-MICAR will
"remember" the last file that was opened, so unless the user specifically closes a file (see
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CLOSING A FILE, pg. 55) the last opened file will be open and ready each time Super-
MICAR is started.

About the Main Screen

The main screen of Super-MICAR has several useful features:

1. At the top of the main screen will be the title (Super-MICAR). This line will also
show the file name of any open certificate file (see Opening an Existing File, pg.
19).

2. The second line of the screen holds the menu bar. The menu bar has several words
on it, called Menu Options. Each Menu Option has several Functions that can be
used. See Using the Super-MICAR Menu System (pg. 13) for more details.

3. At the bottom of the screen is a bar displaying some useful information:

A. In the center, a note appears about the {F1} key. The {F1} key will display
Super-MICAR's online Help feature. This will give brief instructions about
whatever part of Super-MICAR is currently being used.

B. In the lower right corner is a clock showing the current time.

C. The lower left corner displays useful information concerning the current
process. For example, if you are editing a certificate, the lower left corner
displays a message describing the field in which the cursor is located. During
processing, this area displays the certificate number of the record currently
being processed.

Creating a New Certificate File

There are two ways to open a certificate file for use with Super-MICAR. The first way is
by Creating a New Certificate File (see below). The second way is by Opening an
Existing File (pg. 19). Before data can be entered into a certificate file, a file must be
created and opened. To create a new certificate file, follow these steps:

1. From the main screen, press {ALT-F} to select the File Menu Option.
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Figure 3:  A request for a new certificate filename.

2. Use the up and down arrow keys to highlight the Create New File Function and
press {ENTER}.

3. If a file is currently open, a message window will be displayed.

A. To close the currently open file and open a new one, press {Y} and go on to
step 4.

B. To abort opening a new file and keep using the currently open file, press {N}.
The main screen will be re-displayed. Continue using Super-MICAR normally.

4. A window will be displayed (see Figure 3) requesting a filename. Type in the
desired 7 character filename WITHOUT the extension and press {ENTER}. If a
file with the entered filename already exists in the <SUPMICAR/DATA>
directory, a message window will be displayed. Press {ENTER} and re-enter the
filename. 

Example: NC93001 {ENTER}

See the Super-MICAR System Manager's Manual for information on suggested file
name conventions.
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Figure 4:  Confirm creation of a new certificate file.
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Figure 5:  The Specify Header Information screen.

5. A second window will then be displayed (see Figure 4) asking to confirm the
creation of the new file.

A. To create a new file type {Y}. The header information screen (step 5) will be
displayed.

B. To abort creation of the new file and return to the main screen, type {N}.

6. When the file is created, the Specify Header Information screen (Figure 5) will be
displayed. The header information will be the same for each record in the file. Fill
in the appropriate header information as follows:
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Shipment - A number from 00-15 commonly used to indicate the
receipt month or processing month.

Lot # - A number from 000-999. Some states will use "book
number."

Data Year - The last digit for the year of the death certificate
(Example: 1991 = 1, 1997 = 7).

State Code - A number identifying the state from which the death
certificate originates. (These states codes are listed in
APPENDIX A, pg. 71). If a two letter abbreviation for a
state is entered, the program will automatically insert the
correct NCHS state code. If the program does not
recognize the abbreviation, it will display an error
message and then a pick list of states. Entering a
question mark {?} in this field will cause a pick list of
states to be displayed.

Coder Status - A number from 0-9 used to identify the status of the
coder.

Example: Codes for a batch of certificates being processed for data year 1987,
from the State of Alaska, with lot number 303, shipment 02, and coder status is
the production coder would have the following entries: Shipment 02, Lot #
303, Data Year 7, State Code 02, Coder Status 1.

7. To save the header information and open the database file for use, press
{CTRL-ENTER}. The main screen will be re-displayed with a new filename at the
top.

8. To exit the Specify Header Information screen without saving, press {ESC}. The
main screen will be re-displayed.

Opening an Existing File

The steps below tell how to open an existing certificate file for use with Super-MICAR.

1. From the main screen, press {ALT-F} to select the File Menu Option.
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Figure 6:  The File Selection Window.

2. Use the up and down arrow keys to highlight the Open Existing File Function and
press {ENTER}.

3. If a file is currently open, a message window will be displayed.

A. To close the currently open file and open a new one, press {Y} and go on to
step 4.

B. To abort opening a new file and keep using the currently open file, press {N}.
The main screen will be re-displayed. Continue using Super-MICAR normally.

4. A file selection window (see Figure 6) will be displayed.

5. Use the up and down arrow keys to highlight the desired file in the Pick List of
Files. Press {ENTER}.

6. The main screen will be re-displayed with the name of the open file at the top.
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ENTERING AND SAVING CERTIFICATE DATA

There are several Functions that can be used to enter and save data in Super-MICAR. It is
recommended that a sequence check (see Generating a Sequence Check, pg. 66) and
misspellings/illegibles check (see Marking Misspellings/Illegibles, pg. 38, and
Correcting Misspellings/Illegibles, pg. 39) be performed after all of the certificate data
has been entered.

Adding Certificates

In order to add certificates, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Adding certificates to a file is the primary data entry function. Use the instructions below
to add certificates to an open file. Note that I&O data can also be entered while using the
Add Certificates Function. See Editing Industry/Occupation (pg. 35) for more
information.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Add Certificates Function and
press {ENTER}.

3. A window will appear showing the number of certificates that can be entered. This
number is determined by the amount of free space on the hard drive. Press
{ENTER}.

4. The Certificate Information Screen (see Figure 7) will be displayed.

5.  Table 3 lists the special keys and their functions for adding certificates.



National Center for Health Statistics Super-MICAR

Page 22 Data Processing Manual

Table 3: Function Keys For Adding Certificates

{F7} Print Current Certificate. Prints the currently displayed
certificate out on the printer.

{F9} Additional Information. Switches to the ADDITIONAL
INFORMATION SCREEN. See Editing Additional
Information (pg. 30). The text next to this key will
switch from Add to Edit when AI has been entered.

{ALT-1} Places the cursor on the Part I, line A field.

{ALT-2} Places the cursor on the Part II field.

{ALT-D} Press ALT-D to indicate that a line number (Ib, Ic, Id)
or the phrase 'Due to' are marked out on the certificate.
When ALT-D is pressed, the line number will
disappear. Pressing ALT-D a second time will restore
the line number.

{ALT-F9} Saves the current certificate and exits the editing screen.

{ALT-I} Press ALT-I to indicate that the certificate contains
more information than could be typed in the fields on
the screen. This marks the entry as being incomplete,
and the abbreviation (INC) will appear on the screen
after the certificate number.

{CTRL-ENTER} Saves the certificate information on disk.

{ESC} Exits this menu function and returns to the
CERTIFICATE EDITING submenu.

{SHIFT-TAB} Moves the cursor to the previous field.

{TAB} Moves the cursor to the next field.

6. Enter the following certificate information in the corresponding fields on the
screen. NCHS rules on special cases that affect the data entered have been
provided as notes after each field description. Remember, the {TAB} and {SHIFT-
TAB} keys can be used to move from field to field.



Super-MICAR National Center for Health Statistics

Data Processing Manual Page 23

Certificate - Enter the certificate number. The certificate number is usually in the
upper right hand corner of the death certificate. It is also called the State File
Number on the certificate. The abbreviation (INC) indicates that the certificate
contains more information than could be typed in the fields on the screen. See
Table 3, {ALT-I} above.

A. If another certificate with the same certificate number as the one being
saved already exists in the database file, a message window will be
displayed.

B. The message window will inform the user of the specific problem (in this
case, attempting to add a duplicate certificate number). Press any key to
return to the Enter Certificate Information screen and make corrections.

Sex - Type M for Male, F for Female, or U for Unknown. If Sex is not stated on
the certificate, determine sex by name. Enter a U for Unknown.

Date of Death - Enter a two digit month/day (Example: 08/19). If any element of
the date of death is unknown, enter '99' for the month (if the month is unknown) or
'9999' for the year (if the year is unknown). Thus, a totally unknown date would be
entered as 99/9999.

Age: Number of Units - Enter the age of the decedent. The units of time (years,
months, minutes, etc) will be entered in the Unit field (Example: For 27 years old,
type 27; for 3 days, type 3). 

Age: Unit - The units of time for the Age: Number of Units field. Units will be
given in minutes, hours, days, months, or years. Type {?} and press {ENTER} to
obtain a list of valid units. Highlight the desired unit name with the arrow keys and
press {ENTER} to select it. If nothing is entered in this field, 'YEARS' is assumed
and will be automatically entered into this field. 

A. If the Age (Number of Units) entry on the certificate has an entry of "few
minutes" or "few hours" on the certificate, leave the Age (Number of Units)
field on the screen blank and enter the appropriate Unit. Example: If the
certificate reports age as "few minutes," leave the Age (Number of Units)
field blank and type MINUTES in the UNIT field.

B. If age is not reported on the certificate, derive the decedent's age from the
Date of Birth and Date of Death entries on the certificate.
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Certificate: 000014     Sex:              Date of Death:
Age:                    Unit:             State of Death:

Conditions Causing Death Duration
Ia:
Ib:
Ic:
Id:

II:

Manner of Death: Date of Injury: Injury at Work?:

Injury Description:

Place of Injury: Date of Surgery:

Activity Code: State-Specific Data:

F9: Add AI Screen Alt-U: Undo Ctrl-Enter: Save
Alt-O: Occ/Ind Screen Alt-F9:     Save/Exit

Esc:        Exit

Field Description F1-Help Record Count      2 58pm

Figure 7:  The Certificate Information Screen.

C. If Age and the Date of Birth entries on the certificate are blank, leave the
Age (Number of Units) field blank on the screen. Enter the UNIT as
indicated on the certificate, or type UNKNOWN if units are not indicated.

D. If age cannot be determined from the certificate, but entries of "newborn,"
"infant," etc. on the certificate indicate an age of less than 1 year old, leave
the Age (Number of Units) field on the screen blank and type HOURS in
the UNIT field.

E. Disregard fractions reported in the number of units for age on the
certificate.

F. If the number of units on the certificate is reported with "approximately,"
"about," etc., enter the number only.
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State of Death - Super-MICAR will automatically fill in the state code using the
header information. NOTE: The state code can only be changed using the
Edit/Browse Header Info Function.

Cause of Death, Part I - Type in the cause of death exactly as it appears on the
death certificate. Do not make any alterations. If any word or words in the Cause of
Death are illegible, type ILLEGIBLE in place of the illegible words. All other
legible words should still be typed in.

A. Be sure to include any numbers in the Cause of Death section of the
certificate. The following formats can be used for the numbers: number and
dot; number, dot, space; or number and space. Failure to enter the Cause of
Death information correctly WILL CAUSE ERRORS in the data.
Examples:

1.Myocardial Infarction (number and dot)
1. Myocardial Infarction 2. Severe Pneumonia (number, dot, space)
1 Myocardial Infarction (number and space)

The above examples would be typed in exactly as they appear:

I(a) 1. MYOCARDIAL INFARCTION
I(a) 1. MYOCARDIAL INFARCTION 2. SEVERE PNEUMONIA
I(a) 1 MYOCARDIAL INFARCTION

B. If the I(a), I(b), I(c),I(d), "due to" or "as a consequence of" lines are deleted
or marked through on the certificate, press {ALT-D} on the matching line
of the Certificate Information Screen. This will cause the I(a), I(b), I(c), or
I(d) to disappear and indicates that the line number or "due to"/"as a
consequence of" phrase was marked out.

C. Following is a list of symbols, and their meanings, that are commonly used
on the Cause of Death sections of a death certificate. This list is also
included in APPENDIX E - SPECIAL SYMBOLS (pg. 78) at the end of
this manual.

# "Fracture." Substitute for the word "fracture." Example: For "Leg #,"
type "LEG FRACTURE".
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"Decreased." Substitute for the word "decreased." Example: For "
blood pressure," type "DECREASED BLOOD PRESSURE".

"Increased." Substitute for the word "increased." Example: For "
hemorrhaging," type "INCREASED HEMORRHAGING".

o o
I "Hour." Substitute for the word "Hour." Example: For "1 I," type "1

HOUR".

oo
II "Secondary to." Substitute for the words "secondary to." Example: For

oo
"Pneumonia II Gunshot wound," type "PNEUMONIA
SECONDARY TO GUNSHOT WOUND".

1 "Primary." Substitute for the word "primary." Example: For "1  colon
cancer," type "PRIMARY COLON CANCER".

2 "Secondary to." Substitute for the words "secondary to." Example: For
"Pneumonia 2  cardiorespiratory infection," type "PNEUMONIA
SECONDARY TO CARDIORESPIRATORY INFECTION".

c "With." Substitute for the word "with." Example: For "Heat stroke c
_ _

myocardial infarction," type "HEAT STROKE WITH MYOCARDIAL
INFARCTION".

p "After." Substitute for the word "after." Example: For "Spontaneous
_

bleeding p tracheal tube removal," type "SPONTANEOUS BLEEDING
_

AFTER TRACHEAL TUBE REMOVAL".

s "Without." Substitute for the word "without." Example: For "Three
_

weeks s taking medication," type "THREE WEEKS WITHOUT
_

TAKING MEDICATION".

w/ "With." Substitute for the word "with." Example: For "Heat stroke w/
myocardial infarction," type "HEAT STROKE WITH MYOCARDIAL
INFARCTION".

Duration - Type in the interval between the onset of the condition and death
exactly as it appears on the death certificate. Do not make any alterations.
Example: 3-4 WEEKS, 2 1/2 MONTHS, etc.
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A. Duration may be reported using units of time (YEARS, MONTHS,
WEEKS, DAYS, HOURS, etc.) or with words such as BRIEF, CHRONIC,
CONGENITAL, MOMENTS, NEWBORN, etc.

B. Some of the special symbols listed under Cause of Death, Part I (step F)
also apply to the Duration field. A complete list of these symbols also
appears in APPENDIX E - SPECIAL SYMBOLS (pg. 78) of this manual.

C. If a number other than a "1" or a "2" appears with a degree symbol
(Example: 8 ) in the Duration, ignore the number and symbol. Do not enter
the number and symbol.

Cause of Death, Part II - Type in any other significant conditions that are listed in
the Cause of Death section of the death certificate in the order as reported.

A. If more than one entry for Part II is listed on the certificate, enter the
information in the order it appears on the certificate. Begin with the upper
leftmost entry in Part II and work down and to the right, separating entries
with a semicolon (;) if there is more than one entry on the same line.

B. All abbreviations and symbols listed in APPENDIX E - SPECIAL
SYMBOLS (pg. 78) apply to Part II.

Manner of Death - Type in the code for the Manner of Death listed on the
certificate. Type a question mark {?} and press {ENTER} to display a pick list of
valid codes for manner of death. (The list is reproduced below for convenience.)
Use the arrow keys to highlight the desired entry and press {ENTER} to select it.

1 Accident
2 Suicide
3 Homicide
4 Deferred
4 Pending Investigation
4 Unclassified
5 Undetermined
6 Self-Inflicted
7 Natural
Not Specified
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Date of Injury - Month, day, and year injury occurred (Ex: 01/01/1992). To
indicate an unknown date of injury, enter '99/99/9999'.

A. If the date of an injury or external cause appears anywhere on the
certificate except the Duration section of Part I, enter the date of that injury
or external cause here.

B. If a span of time is reported for month, day, or year for the injury, enter the
earlier date. Example: January 1-7, 1989 would be typed in as 01/01/1989.

C. The Date of Injury cannot be after the date of death.

Injury at Work? - Type a {Y} or leave blank, as reported on the death certificate.

Injury Description - Type in the description exactly as it appears on the death
certificate.

Place of Injury - Type in the Place of Injury as it appears on the death certificate.
The code assigned to this entry is displayed to the right of the field, in parentheses.

Date of Surgery - Date of surgery. Used only for states which have a specific
surgery item on the certificate. To indicate an unknown date of surgery, enter
'99/99/9999' for the year.

A. If "yes" is entered in the "Was operation performed" item on the certificate
and no Date of Surgery is specified, type SURGERY as the last condition
in Part II. Separate SURGERY from any other items in Part II with a
semicolon (;). For example, if "yes" is entered, the certificate data should
be entered as follows:

I(a) CARDIAC ARREST
 (b) BREAST CANCER
 (c)
 (d)
II PNEUMONIA; SURGERY

B. If "yes" is entered in the "Was operation performed" item on the certificate
and surgery (or a named type of surgery) is recorded elsewhere on the
certificate, do not add SURGERY to Cause of Death, Part II. For example,
if "yes" is entered with a specific type of surgery already named, the
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certificate data would be entered as follows:

I(a) CARDIAC ARREST
 (b) BREAST CANCER; MASTECTOMY
 (c)
 (d)
II PNEUMONIA

C. If "yes" and a date of surgery are entered in the "Was operation performed"
item on the certificate, do not enter SURGERY in Cause of Death, Part I or
II. Enter the date of the surgery in the Date of Surgery item.

D. If diseases, injuries, or named surgeries are reported in the "Was operation
performed" block, enter these diseases, injuries, or named surgeries as the
last entry in Cause of Death, Part II.

E. The date of surgery cannot be after the date of death.

Activity Code - Activity the decedent was undertaking when death occurred.
Entering a question mark (?) will cause the following pick list to appear:

0: While Engaged in Sports Activity
1: While Engaged in Leisure Activity
2: While Engaged for Income
3: While Engaged in Other Types of Work
4: While Resting, Sleeping, Eating (Vital Activities)
8: While Engaged in Other Specified Activity
9: During Unspecified Activity
Blank

State Specific Data - For use by the states. This field can hold up to 18 characters
of state-specific data. Consult the System Manager for information on how to use
the State-Specific Data field.

Field Description - Brief instructions for entering data in the field the cursor is
positioned on will be displayed in the bottom left corner of the screen.

Record Count - Number giving the total number of certificates in the file.

7. When the end of the last field has been reached, press {CTRL-ENTER} or
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{PgDown}. The certificate will be saved and a blank screen for a new record will
be displayed. 

8. The Enter Certificate Information screen will be re-displayed with all but one of the
fields blank (the certificate number field will contain data). A new certificate
number will be automatically generated by the program. Go to step 5 above to
enter another certificate.

9. To exit the Add Certificate Function, press the {ESC} key when a new certificate
screen is displayed. NOTE: Pressing {ESC} from a screen that contains data
WILL NOT save that data. Press {ALT-F9} to save the current certificate and exit
the Add Certificates function.

10. The main screen will be redisplayed.

Editing Additional Information

In order to edit AI, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Each record in a Super-MICAR file can have two separate screens of information
associated with it. The first screen, the Certificate Information screen, should contain the
cause of death data as it appeared on the death certificate. On color monitors, this screen is
blue. Certified copies of the death certificate information could be taken from this screen.
The second screen, the Additional Information (AI) screen, contains the information that
will be processed by Super-MICAR. This screen is red on color monitors. The information
on this screen may be different than that on the Certificate Information screen in cases
where information needs to be added to the record as the result of queries. Changes in the
record may also be required to assist the Super-MICAR processor in assigning Entity
Reference Numbers to the medical conditions on the record. For most records, Super-
MICAR will process the original information as it appears on the Certificate Information
screen. When the AI screen is first invoked, the information from the original screen is
copied onto the new screen. After this, the AI screen will always retain the changes made
to it separately from the Certificate Information Screen.



Super-MICAR National Center for Health Statistics

Data Processing Manual Page 31

NOTE: Once a record has an associated AI certificate, changes made to the original
certificate will have no effect on Super-MICAR's processing. Any corrections made to
data on the Certificate Information screen should also be made on the AI screen to
assure that the record processes correctly.

The following sections provide information on entering additional information on the
Additional Information Screen. Additional Information takes only very specific forms in
Super-MICAR, and can come from many sources. The section below describes the types
of AI that can be entered into Super-MICAR.

What Constitutes Additional Information?

In the past, additional information was defined as information gathered as a result of
queries to the physician, results of investigations by coroners or other officials, traffic
accident reports, etc. These definitions still hold true in Super-MICAR. However, the
Super-MICAR Additional Information screen is used for these and other types of data.

Specifically, AI includes any information or changes of information made to the original
certificate. Super-MICAR assumes that preserving the original death certificate
information is important, and therefore, any changes to that information are made on the
Additional Information Screen. These changes can be made in several different places for
several different reasons.

Adding Certificates:
While adding certificates to a database file, additional information from police
reports, pending investigations, or coroner's reports may be included with the
original certificate. Further, there are times when numbers that are spelled out on
the original certificate should be entered as digits on the AI screen. This
information can be entered during the Add Certificates Function by accessing the
Additional Information screen from the Certificate Data screen. To access the AI
screen, press {F9}.

Browsing Certificates:
Specific causes of death are questionable under certain circumstances. Many states
send query letter to the physician asking for confirmation or clarification of the
death conditions when these special cases are encountered. The results of these
query letters can be entered by accessing the AI screen from the Edit/Browse
Certificates Function. To access the AI screen from the Edit/Browse Certificates
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screen, press {F9}.

Reject Processing:
When processing rejected records through the Super-MICAR reject processor, it is
often necessary to make changes to the certificate information in order to get the
record to process completely. These changes may consist of supplying a correct
spelling for a misspelled word, adding punctuation to divide two terms, re-ordering
the terms on a line, or selecting an external cause of death from the External Cause
prompts. (Note: External Cause prompts should only be used by a qualified
MICAR coder.) All of these changes should be made on the AI screen so that the
original certificate data can be preserved unchanged. During processing, the Reject
Editing screen will appear to allow the user to make changes. From the Reject
Editing screen, press {F9} to access the AI screen. (For more information on reject
processing, refer to APPENDIX G - PROCESSING REJECTED RECORDS,
pg. 79.)

During reject processing, if an AI entry for a certificate already exists, the AI
screen will be displayed by the reject processor, bypassing the Reject Editing
screen altogether.

It is important to remember that Super-MICAR will process only the information on the
AI screen if an AI entry for a particular certificate exists. This means that for any
certificate that has both original information and additional information, changes to the
original certificate will have no effect on Super-MICAR's attempts to match causes of
death to their medical entity reference numbers. Only those changes made on the AI
certificate will be processed. Of course, for certificates that have no AI information, the
data on the original certificate is processed.

Accessing the Additional Information Screen

Before the AI screen can be used, the following actions must have already been
performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

The Certificate Information Screen must be displayed (Adding Certificates pg. 21, 30,
or Browsing Through the Certificates pg. 58).
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Super-MICAR 1996: TEST1.DBF
File Edit Process Reports Backup Help

Certificate: 000014 Sex: Date of Death:
Age: Unit: State of Death:

Conditions Causing Death Duration
Ia:
Ib:
Ic:
Id:

II:

Manner of Death: Date of Injury: Injury at Work?:

Injury Description:

Place of Injury: Date of Surgery:

Activity Code: State-Specific Data:

F6: Show ERNs F8: Delete Alt-U: Undo Ctrl-Enter:  Save
Alt-F9: Save/Exit
Esc:         Exit

Field Description F1-Help      2 58pm

Figure 8:  The Additional Information Screen.

The Additional Information Screen can be accessed from the Certificate Information
Screen by pressing {F9}. It functions exactly the same as the Certificate Information
Screen. To use the Additional Information Screen, do the following:

1. Access the Certificate Information Screen for the desired certificate. The
instructions for doing this can be found in the Adding Certificates (pg. 21, 30)
section of this manual.

2. Press {F9}. This will cause a screen very similar to the Certificate Information
Screen to appear (see Figure 8). On a color monitor, the background of this screen
will be red. On a monochrome monitor, the title of the screen, ADDITIONAL
INFORMATION, will appear at the bottom of the screen in bold letters. When the
Additional Information Screen initially appears, the data from the Certificate
Information Screen will be copied onto the AI Screen.
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3. Enter the additional information in the same manner as described in Adding
Certificates (pg. 21, 30). The restrictions on what the data fields can hold is the
same. The special keys and their functions used on the AI SCREEN are listed
below in Table 4.

Table 4: Function Keys For the ADDITIONAL INFORMATION
SCREEN

{ALT-1} Places the cursor on the Part I, line A field.

{ALT-2} Places the cursor on the Part II field.

{ALT-D} Press ALT-D to indicate that a line number (Ib, Ic, Id)
or the phrase 'Due to' are marked out on the certificate.
When ALT-D is pressed, the line number will
disappear. Pressing ALT-D a second time will restore
the line number.

{ALT-I} Press ALT-I to indicate that the certificate contains
more information than could be typed in the fields on
the screen. This marks the entry as being incomplete,
and the word INCOMPLETE will appear in the top
right corner of the screen.

{CTRL-ENTER} Saves the certificate information on disk.

{ESC} Exits the AI screen without saving any changes and
returns to the Certificate Information screen.

{CTRL-DEL} Deletes all of the Additional Information on the AI
screen.

A. If "pneumoconiosis" is listed on the death certificate and the decedent's
occupation is "coal worker" or "miner," enter COAL WORKERS
PNEUMOCONIOSIS.

B. On some occasions, additional information (A.I.) will be attached to the death
certificate. If the A.I. states the underlying cause of a specific disease in Part I,
the A.I. is considered to be reported on the line below the indicated disease.
Adjust all other reported conditions accordingly. For example:

I(a) Congestive heart failure
 (b) Arteriosclerosis
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 (c)
 (d)
II

A.I.: The underlying cause of the congestive heart failure was ASHD

The above should be typed in as:

I(a) CONGESTIVE HEART FAILURE
 (b) ASHD
 (c) ARTERIOSCLEROSIS
 (d)
 II

If a disease is modified by A.I., treat the disease as modified by the A.I. where
the disease is first reported. Example:

I(a) Pneumonia

A.I. Lobar pneumonia

The above should be typed as:

I(a) LOBAR PNEUMONIA

C. If an "amended certificate" is submitted, enter the data on the amended
certificate only.

6. When all of the changes have been made, press {CTRL-ENTER} to save the
information. After changes have been made and saved on the AI SCREEN,
subsequent viewings of the AI SCREEN will show the additional information.
Also, the text next to the {F9} key on the screen will switch from "Add" to "Edit."

Editing Industry/Occupation

Before Industry and Occupation (I&O) data can be edited, the following actions must have
already been performed:
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Super-MICAR 1996: TEST1.DBF
File Edit Process Reports Backup Help

Certificate: 000014 Sex: Date of Death:         
Age: Unit: State of Death:        

  6444444444444444444444444444444444444444444444444447 Duration
Ia5       Enter Industry/Occupation          5
IbK))))))))))))))))))))))))))))))))))))))))))))))))))M
Ic5                                          5
Id5 Occupation:                              5
  5                                          5
II5 Industry:                                5
  5                                          5
Ma5 Education:                               5?:
In5                                          5
  5                ESC: Exit                 5
Pl9444444444444444444444444444444444444444444444444448

Activity Code: State-Specific Data:

F5: Search F9: Add AI Screen Alt-U: Undo Ctrl-Enter: Save
F6: Show ERNs Alt-O: Occ/Ind Screen Alt-F9: Save/Exit
F7: Print Esc:    Exit
Field Description F1-Help    2 58pm

Figure 9:  The Edit Industry and Occupation window.

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

The Certificate Information Screen must be displayed (Adding Certificates pg. 21, 30,
or Browsing Through the Certificates pg. 58).

To enter industry, occupation, and education data, the Certificate Information Screen must
be displayed. Use the following steps:

1. From the Certificate Information screen, press {ALT-E} to access the Edit Menu
Option.

2. Use the up and down arrow keys to highlight the Edit Industry/Occupation
Function. Press {ENTER}.

3. An Edit Industry and Occupation window (see Figure 9) will be displayed.
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4. Type in the following information. The {TAB} and {SHIFT-TAB} keys can be
used to move through the fields on the Edit Industry and Occupation window.

A. Enter the Industry as it appears on the certificate. Press {ENTER}.

B. Enter the Occupation as it appears on the certificate. Press {ENTER}.

C. Type in the appropriate Education code, or a {?} for a pick list of valid codes.
If this field is left blank, Super-MICAR will check the person's age. If the age
is less than 4 years, the Education code will default to '00'. If Education is left
blank and the age is greater than 4 years or unknown, the Education will be
coded as '99'.

5. Industry and Occupation data will be saved when all the displayed fields have data
in them.
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CORRECTING MISSPELLED OR ILLEGIBLE WORDS

Often, certificates will fail to process because they contain misspelled words or words that
were entered as "ILLEGIBLE" during data entry. These two conditions are easily
remedied through the use of Super-MICAR's Misspellings and Illegibles functions. There
are two functions related to this task. The first Function, Mark Misspellings/Illegibles,
goes through the entire certificate file and marks any records containing words that were
not found in Super-MICAR's dictionary and any certificates containing the word
ILLEGIBLE. (When searching for misspellings, Super-MICAR checks the words in the
Part I Cause of Death fields and the Part II fields. Illegibles are checked for in these fields
as well as the interval fields and the injury description.) The second Function, Correct
Misspellings/Illegibles, allows the user to display and correct those records in which
misspelled or illegible words were found.

Note that both illegibles and misspellings need not be marked. The user can choose to
mark one or both. Data entered through the Add Certificates Function is checked for
misspellings at that time. Thus, it may only be necessary to mark and correct illegible
words.

Marking Misspellings/Illegibles

This function is used to mark certificates containing misspelled words or the word
"ILLEGIBLE". Mark Misspellings/Illegibles MUST be used before the Correct
Misspellings/Illegibles Function can be performed. To mark misspellings and illegibles,
follow these steps:

1. From the main screen, press {ALT-P} to select the Process Menu Option.

2. Use the up and down arrow keys to highlight the Mark Misspellings/Illegibles
Function. Press {ENTER}.

3. A window (see Figure 10) will be displayed:

A. To mark misspellings only, press {S}.

B. To mark illegibles only, press {I}.

C. To mark both misspellings and illegibles, press {B}.
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+))))))))))))))))))))))))))))))))))))))))))))))))))),
* Check spelling, illegibles, or both?      *
*                                           *
*      Both (     Spelling (   Illegibles (   *
*    &&&&&&&&&&    &&&&&&&&&&    &&&&&&&&&&    *
.)))))))))))))))))))))))))))))))))))))))))))))))))))-

Figure 10:  Mark misspellings, illegible entries, or both.

4. Once a choice is made, a progress bar (see Figure 12) will be displayed showing
the percentage of the file that has been searched for misspellings and/or illegibles.
To abort the marking process, press the {ESC} key.

5. When the entire file has been processed, a message window will be displayed.
Press {ENTER}.

6. The main screen will be displayed. The Correct Misspellings/Illegibles Function
can now be used.

Correcting Misspellings/Illegibles

This Function is used to correct misspellings and/or illegibles that were marked using the
Mark Misspellings/Illegibles Function. Note that the Mark Misspellings/Illegibles
Function MUST be used before the misspellings/illegibles can be corrected.

1. From the main screen, press {ALT-P} to select the Process Menu Option.

2. Use the up and down arrow keys to highlight the Correct Misspellings/Illegibles
Function. Press {ENTER}.

3. A window (see Figure 10) will be displayed:

A. To edit spelling errors, press {S}.

B. To edit illegibles, press {I}.

C. To edit both spelling errors and illegibles, press {B}.
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6444444444444444444444444444444444444444444444444444444444447
5           ACUTE MIOCARDIAL INFARCTION            5
5                                                  5
5                                                  5
5                                                  5
5                                                  5
5                                                  5
9444444444444444444444444444444444444444444444444444444444448
644444444444444444444444444444444444444444444444444444444447
5                   MIOCARDIAL                    5
5                                                 5
5              This word not found.               5
5                                                 5
5         Accept, Retype, or Spellcheck?          5
5                                                 5
5          Accept (     Retype (    Spellcheck (    5
5         &&&&&&&&&&    &&&&&&&&&&    &&&&&&&&&&&    5
5                                                 5
944444444444444444444444444444444444444444444444444444444448

Figure 11:  The Spell-Check window.

4. A progress bar will appear as Super-MICAR checks the data files. When a
misspelled word is encountered, the Spellcheck window (see Figure 11) will be
displayed.

5. The Spellcheck Selection window displays the misspelled word and the line that
contains it, and displays three options: Accept, Retype, or Spell. Each option is
described below.

Accept Selecting this option causes the word to be accepted as it is and
spell-checking continues with the next misspelled or illegible word.
Press {A} to accept the word.

Retype Selecting the Retype option causes a window (see Figure 11) to be
displayed. The user can enter a new spelling for the misspelled
word. Press {R} to display the retyping window. Type the new
spelling over the old word. Press {ENTER} to accept the new word.
If the new word is also misspelled, the user can accept, retype, or
spellcheck it again. When a known word is entered, the misspelled
word is replaced in the entry and spell-checking continues with the
next misspelled or illegible word. Further, the misspelled word and
the correct spelling are remembered so that later instances of the
same misspelling are corrected automatically, but only for the
current run of Spellcheck. Subsequent Spellchecks will use the
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standard dictionary.

Spellcheck Selecting the Spellcheck option displays a list of possible spellings
in a pick list. The user may select the correct spelling from this list.
Press {S} to display the pick list. If the list does not contain the
proper spelling of the word, press {ESC} to return to the spell-
check selection window and choose either Accept or Retype to
accept or retype the word. To select a word from the pick list, use
the up and down arrow keys to highlight the correct word. When
the correct word is highlighted, press {ENTER} to select it. The
misspelled word is replaced with the correct spelling and spell-
checking continues with the next misspelled or illegible word.
Further, the misspelled word and the correct spelling are
remembered so that later instances of the same misspelling are
corrected automatically.

6. When a record containing an illegible word in encountered, the Edit/Browse
Certificates screen for that record is displayed. Use the editing keys described in
the section Browsing Through the Certificates (pg. 58) above to edit the record,
replacing the illegible word. When all editing is complete, press {CTRL-ENTER}
to save the record and go on to the next record containing a misspelled or illegible
word.

7. When all misspelled and illegible words have been corrected, a window will appear
saying that the spelling check is complete. Press {ENTER} to return to the main
screen.
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PROCESSING A CERTIFICATE FILE

Processing is the method Super-MICAR uses to convert the cause of death information
into NCHS's Entity Reference Numbers (ERN). There are three phases of processing in
Super-MICAR: Record Processing, Reject Processing, and Additional Information
Processing. Each of these is described below. It is intended that these three processing
options be selected in order to insure that the certificate data is processed correctly. The
three options are:

Record Processing The first phase of Super-MICAR processing produces output
for all certificates in the database that are perfectly correct. It
marks the certificates containing errors as rejects. This process
runs without user interaction and can be run through a batch
process (see BATCH PROCESSING FROM THE
COMMAND LINE in the Super-MICAR System Manager's
Manual).

Reject Processing The second phase of Super-MICAR processing is an interactive
session in which only the rejects from the Record Processing
are run. A trained MICAR coder can help Super-MICAR
processing by changing the data on the certificate using MICAR
data entry rules, making additions on the AI screen, or selecting
external cause codes from the External Cause prompts. The
results of Reject Processing are merged with the results of
Record Processing to produce a complete MICAR file. NOTE:
Proper use of the External Cause Prompts requires training in
MICAR data entry. If the user has not been trained, he or she
should not use the External Cause Prompts.

Additional Information The third phase of Super-MICAR processing is designed to
Processing allow the user to process any certificates that were changed as

the result of collecting additional information. Additional
Information, in this sense, is any information that was provided
after reject processing was completed. When Additional
Information processing is selected, only those certificates that
have been modified since the rejects were run will be processed.

Instructions for selecting and using each of these processing options are provided below.
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*   Processing File C:\SMICAR\DATA\TEST1.DBF (ESC Exits)   *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))1
*                             46%                          *
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* 0           Estimated time remaining: 00:00:00     100   *
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Figure 12:  A bar graph showing the progress of file processing.

Processing Records

Before records can be processed, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Please note that the file must have certificates in it to process.

The Process All Records Function can process approximately 2500 certificates per hour
on an average computer. The user does not need to do anything while the processing is
occurring. After the processing is finished, the user can generate a batch error listing (see
GENERATING REPORTS, pg. 66) and then perform any editing needed as described in
ENTERING AND SAVING CERTIFICATE DATA (pg. 21) or process the rejects as
described in Processing Rejects (pg. 44). The instructions for Processing Records are:

1. From the main screen, press {ALT-P} to select the Process Menu Option.

2. Use the up and down arrow keys to highlight the Process All Records Function and
press {ENTER}.

3. A message window will be displayed saying that the dictionaries are being
initialized.

4. When the dictionaries are initialized, a progress bar (see Figure 12) will be
displayed on the screen showing what percentage of the data file has been
processed.

5. The certificate number for the certificate currently being processed is displayed in
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the lower left corner of the screen.

6. Occasionally, Super-MICAR will take a long time to process a certificate. In these
cases, the word "Thinking" will be displayed in the lower left corner of the screen,
beside the certificate number. A 'spinning wheel' beside the word indicates that
Super-MICAR is still processing the record.

7. No other activity is needed during processing.

8. When the processing is complete, a coding stats report will be displayed.

A. To print out a copy of the coding stats report, press {Y}.

B. To abort, press {N}.

9. The main screen will be re-displayed.

Processing Rejects

Before records can be processed, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Please note that the file must have certificates in it to process.

In Processing Rejects, Super-MICAR will stop the processing whenever a term that it
cannot translate is encountered. At the user's option, the user may edit the cause of death
information and process the rejected record again. NOTE: This Function cannot be used
until the Process All Records Function has been used. See Processing Records (pg. 43)
for more details. The details of Processing Rejects are as follows:

1. From the main screen, press {ALT-P} to select the Process Menu Option.

2. Use the up and down arrow keys to highlight the Process Rejects Function and
press {ENTER}.

3. A message window will be displayed saying that the dictionaries are being loaded.
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4. When the dictionaries are loaded, a progress bar (see Figure 12) will be displayed
on the screen showing what percentage of the data file has been processed.

A. When Super-MICAR finds a mismatch or an error, a message window will be
displayed. To make a correction, press the {E} key. To accept the error as
correct and continue with the processing, press the {A} key (the record is
marked as correct and will not be re-processed during future reject runs). To
cancel editing of the error and return to processing, press the {C} key (the
record will still be marked as rejected).

B. If the {E} key is pressed to make corrections, the user will be returned to the
Certificate Information screen (refer to Adding Certificates, pg. 21, 30, for a
description of the Certificate Information screen) or the Additional Information
Screen, whichever is most appropriate (refer to Editing Additional
Information (pg. 30) for a description of the AI screen). Super-MICAR will
fill the fields on the screen with certificate information. Make changes to the
fields as described in ENTERING AND SAVING CERTIFICATE DATA
(pg. 21). Note that Table 5 below contains a list of special keys and their
functions:

Table 5: Function Keys For Processing Rejects

 F1 Displays the Help file.

 F6 Show Processed Data. Displays the cause of death
information and entity reference numbers for the cause of
death text (see Figure 13). Press the {ESC} key to return
to the Enter Certificate Information screen.

 F9 Additional Information. Switches to the Additional
Information Screen. See Editing Additional Information
(pg. 30).

 ESC Returns to processing without making any changes. The
certificate is marked as correct and will not be processed in
future sessions. Use this key if you have determined that
no changes can be made that will alter the certificate's
processing.

 ALT-1 Places the cursor on the Part I, line A field.



National Center for Health Statistics Super-MICAR

Table 5: Function Keys For Processing Rejects

Page 46 Data Processing Manual

 ALT-2 Places the cursor on the Part II field.

 ALT-D Press ALT-D to indicate that a line number (Ib, Ic, Id) or
the phrase 'Due to' are marked out on the certificate. When
ALT-D is pressed, the line number will disappear. Pressing
ALT-D a second time will restore the line number.

 ALT-I Press ALT-I to indicate that the certificate contains more
information than could be typed in the fields on the screen.
This marks the entry as being incomplete, and the word
INCOMPLETE will appear in the top right corner of the
screen.

 CTRL-ENTER Saves changes to the certificate. A message window will
be displayed asking if the user wishes to save changes to
the certificate. Type {Y} to save the changes. Type {N} to
leave the file unchanged. The user will then be returned to
processing

C. When {F6} is pressed, a screen like the one in Figure 13 will be displayed.
Press {ESC} to return to the Enter Certificate Information screen. 

D. The user must look at the data line (see Figure 13) and determine if the entry is
an external cause. If the item is an external cause, the external cause prompts
will need to be used to generate an External Cause Code for the Cause of
Death.

NOTE: Proper use of the External Cause Prompts requires training in MICAR
data entry. If the user has not been trained, he or she should not use the
External Cause Prompts. Press {ESC} to return to the Certificate
Information screen.
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644444444444444444444444444444444444444444444444444444444444444444447
5           Processed Output (ESC to Exit)                5
5                                                         5
5 L/T ENTITY                                 DUR  ERN     5
5 1/1 MULTIPLE TRAUMATIC INJURIES            504  097724  5
5 2/1 HANDGUN HEAD SHOT                           999999  5
5                                                         5
5                                                         5
5                                                         5
5                                                         5
5                                                         5
5                                                         5
5                                                         5
5                                                         5
944444444444444444444444444444444444444444444444444444444444444444448

Figure 13:  The Processed Entries and their Entity Reference Numbers.

+))))))))))))))))))))))))))))))),
*  Select Type of Firearm  *
/)))))))))))))))))))))))))))))0)1
*Pistol                  * *
*Shotgun                 *$*
*Hunting Rifle           *$*
*Military Firearm        *$*
*Other Specified Firearm *$*
*Unspecified Firearm     * *
.)))))))))))))))))))))))))))))2)-

Figure 14:  An External Cause list for Firearms.

To access the external cause prompts, follow these steps:

1) If the AI screen is not already displayed, access it by pressing {F9}.
(External cause prompts are only available through the AI screen.) Use the
{TAB} key to position the cursor on the line where the external cause if
first mentioned. Put two greater than signs {>>} in the field at the point
where the external cause is first mentioned, then press {ENTER}. Note that
more than one External Cause can be placed on a line. Also note that
external cause prompts can only be placed in the Cause of Death Part I, A-
D, Part II, and the Injury Description fields.

2) A list of prompts similar to the list in Figure 14 will appear. Highlight the
entry that most closely applies to the listed injury or cause of death at the
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top of the screen.

3) As more lists appear on the screen, the entries become more specific.
Super-MICAR will build an External Cause Code based on the selections
made from the lists. Press {CTRL-ENTER} to save the changes and return
to processing.

4) When the External Cause Code is complete, no more lists will be displayed
on the screen. The code is embedded in the line from which the External
Cause prompts were called. The user may need to delete words or phrases
on the certificate that relate to the encoded External Cause. Press {CTRL-
ENTER} to save the changes and return to processing.

5. When the processing is complete, a coding statistics report will be displayed.

A. To print out a copy of the coding stats report, press {Y}.

B. To abort, press {N}.

6. The main screen will be re-displayed.

Processing Additional Information

Before records can be processed, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Please note that the file must have certificates in it to process.

Sometimes, Additional Information will be received after the certificates have been
processed (as in a pending investigation, for example). In these cases, the user should edit
the certificate's Additional Information and then process the AI. Once AI is processed, a
MICAR 100 file for the modified records should be generated, then the batch should be
backed up and sent to NCHS. A chart depicting the Additional Information Processing
cycle is given at the end of this section. To process Additional Information, follow these
steps:

1. From the main screen, press {ALT-P} to select the Process Menu Option.
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2. Use the up and down arrow keys to highlight the Process Additional Information
Function. Press {ENTER}.

3. A message window will be displayed saying that the dictionaries are being loaded.

4. When the dictionaries are loaded, a progress bar (see Figure 12) will be displayed
on the screen showing what percentage of the data file has been processed.

A. When Super-MICAR finds a mismatch or an error, a message window will be
displayed. To make a correction, press the {Y} key. To continue with the
processing, press the {N} key.

B. If the {Y} key is pressed to make corrections, the Additional Information
Screen will be re-displayed. Refer to step 3B under Processing Rejects (pg.
44) for information on how to make corrections. Refer to APPENDIX G -
PROCESSING REJECTED RECORDS (pg. 79) for information on types of
rejected records and how they can be modified so that Super-MICAR can
encode them.

5. When the processing is complete, a coding stats report will be displayed.

A. To print out a copy of the coding stats report, press {Y}.

B. To abort, press {N}.

6. The main screen will be re-displayed.
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Figure 15:  Export all certificates or only edited certificates.

GENERATING A MICAR100 FILE

Before a MICAR100 file can be generated, the following actions must have already been
performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Please note that the file must have certificates in it to process.

The file must have been processed already (PROCESSING A CERTIFICATE FILE,
pg. 42 - choose one of the types of processing).

After the certificate file has been processed, a MICAR100 file may need to be generated.
The MICAR100 file contains all of the processed entity reference numbers and their
identifying information. This file will only need to be generated if it is to be uploaded to a
mainframe for processing. Ask your System Manager if this file should be generated.

1. From the main screen, press {ALT-R} to select the Process Menu Option.

2. Use the up and down arrow keys to highlight the Generate MICAR100 File
Function. Press {ENTER}.

3. A window (see Figure 15) will be displayed.

A. To generate a MICAR100 file containing information for all the certificates in
the database, press {A}.

B. To generate a MICAR100 file containing information for only those certificates
that have been reprocessed since the previous export, press {C}. This is most
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often used after processing Additional Information, since in these cases, the
primary MICAR100 file has already been shipped for processing and only the
certificates that have changed need to be exported.

4. A progress bar (Figure 12) will be displayed showing what percentage of the
certificates have been exported to a MICAR100 file.

5. When the MICAR100 file is complete, the main screen will be re-displayed.
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644444444444444444444444444444444444444444444444444444444444444444447
5                                                          5
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5                                                          5
5                                                          5
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Figure 16:  Choose a drive to put the backup file on.

CREATING BACKUPS

There are several backup Functions that will be used often by the user: The Backup All
Files Function and the Backup for NCHS Function. The Backup and Remove Function is
described in the Super-MICAR System Manager's Manual. Because data security is an
important issue, each Super-MICAR site will have different backup procedures. Ask the
System Manager for instructions on the proper types and times for using backup
procedures.

Backing Up All the Files

Before backups can be created, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Please note that the file must have certificates in it in order to create the backup.

It is strongly recommended that a backup of all the files be made at the end of the day.
This will help prevent data loss from corrupted files or other problems. The Backup All
Files Function creates a single backup file, called filename.SBK, that contains all of the
files associated with a batch of certificates. To make a backup of all the files, do the
following:

1. From the main screen, press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Backup All Files Function. Press
{ENTER}.
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NOTE: The backup file will not necessarily have the same name as the  open file. The
NCHS backup will be named SSYYLLL.SUP, where SS is the state code, YY the data
year, and LLL the lot number. .SUP is the file extension.

3. A window (see Figure 16) will be displayed requesting a drive name (such as A,
B, or C) to put the backup file on. Type in the letter of a valid drive and press
{ENTER}.

4. After a valid drive has been entered, a message window will be displayed while the
backup is being made.

5. When the backup is complete, the main screen will be re-displayed.

Creating Backups for NCHS

Before backups can be created, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

Please note that the file must have certificates in it in order to create the backup.

After all editing and processing has been finished, backups of the certificate data should
be made. The backups should be sent to NCHS for further processing.

1. From the main screen, press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Backup for NCHS Function.
Press {ENTER}.

3. A window (see Figure 16) will be displayed requesting a drive name (such as A,
B, or C) to put the backup file on. Type in the letter of a valid drive and press
{ENTER}.

4. After a valid drive has been entered, a message window will be displayed while the
backup is being made.

5. When the backup is complete, the main screen will be re-displayed.



Super-MICAR National Center for Health Statistics

Data Processing Manual Page 55

CLOSING A FILE

A certificate file will normally be closed when the user is ready to start on a new batch of
certificates (which involves creating a new certificate file, as described in Creating a New
File, pg. 16). At other times, Super-MICAR will require that the certificate file be closed
to perform some of the menu functions. In any case, closing a Super-MICAR file is very
easy:

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Close File Function and press
{ENTER}.

3. The currently open file will be closed. The filename will disappear from the top of
the screen. Super-MICAR is now ready to open another file for processing.
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EDITING FUNCTIONS

Super-MICAR has several Functions that can be used to edit a certificate file and the data
it contains. The most commonly used Function for this will be the Edit/Browse Function
(see Browsing Through the Certificates on pg. 58). Other Functions that will be used to
edit certificate data are: the Edit/Browse Header Information function, the Edit Additional
Information Function, Edit Industry/Occupation Function, and the Find a Record
Function. The Exit Super-MICAR, Delete Records, and Show Processed Output can also
be used and are described in other parts of this manual.

Editing Header Information

Before header information can be edited, the following actions must have already been
performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

The steps below are used to edit the certificate file's header information. This Function can
be used only when a certificate file is open.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit/Browse Header Info
Function and press {ENTER}.

3. The Specify Header Information screen (Figure 17) will be displayed. Fill in the
appropriate header information as follows:

Shipment - A number from 00-15 commonly used to indicate the
receipt month or processing month.

Lot # - A number from 000-999. Some states will use "book
number."

Data Year - The last digit for the year of the death certificate
(Example: 1991 = 1, 1997 = 7).
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Figure 17:  The Specify Header Information screen.

State Code - A number identifying the state from which the death
certificate originates. (These states codes are listed in
APPENDIX A - NCHS STATE CODES, pg. 71). If a
two letter abbreviation for a state is entered, the program
will automatically insert the correct NCHS state code. If
the program does not recognize the abbreviation, it will
display an error message and then a pick list of states.
Entering a question mark {?} in this field will cause a
pick list of states to be displayed.

Coder Status - A number from 0-9 used to identify the status of the
coder.

Example: Codes for a batch of certificates being processed for data year 1987,
from the State of Alaska, with lot number 303, shipment 02, and coder status is
the production coder would have the following entries: Shipment 02, Lot #
303, Data Year 7, State Code 02, Coder Status 1.

4. To save the header information, press {CTRL-ENTER}. The main screen will be
re-displayed.

5. To exit the Specify Header Information screen without saving, press {ESC}. The
main screen will be re-displayed.
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Browsing Through the Certificates

Before the Edit/Browse Function can be used, the following actions must have already
been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

This Function allows the user to manually browse through a certificate file. Other Edit
Functions can be used with the Edit/Browse Function.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit/Browse Certificates Function
and press {ENTER}.

3. The Certificate Information Screen (see Figure 7) will be displayed. Descriptions
of this screen and its fields can be found in the section Adding Certificates (pg.
21, 30) earlier in this manual.

4. The {PgUp} and {PgDn} keys will cause the preceding or next certificate to be
displayed.

5. Any of the following Functions may be used while in Browse:

File - Exit Super-MICAR
Edit - Add Certificate, Edit Additional Information, Edit

Industry/Occupation, Delete Records, Find a Record, Undo
Changes

Process - Show Processed Output (see Showing Processed Output, pg.
62 - this will be available only if the file has been processed.)

6. To edit the data for a certificate, simply type in the changes in the appropriate field.
Editing keys are listed in Table 6.

7. When all of the changes have been made, save the certificate data by pressing
{CTRL-ENTER}.

8. When finished viewing the certificates, press the {ESC} key. The main screen will
be re-displayed.
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Table 6: Function Keys For Editing Certificates

{F7} Print Current Certificate. Prints the currently displayed
certificate on the printer.

{F7} Deletes the currently displayed certificate from the
database.

{F9} Additional Information. Switches to the ADDITIONAL
INFORMATION SCREEN. See Editing Additional
Information (pg. 30).

{ALT-1} Places the cursor on the Part I, line A field.

{ALT-2} Places the cursor on the Part II field.

{ALT-D} Press ALT-D to indicate that a line number (Ib, Ic, Id)
or the phrase 'Due to' are marked out on the certificate.
When ALT-D is pressed, the line number will
disappear. Pressing ALT-D a second time will restore
the line number.

{ALT-F9} Saves the currently displayed certificate and exits the
editing screen.

{ALT-I} Press ALT-I to indicate that the certificate contains
more information than could be typed in the fields on
the screen. This marks the entry as being incomplete,
and the word INCOMPLETE will appear in the top
right corner of the screen.

{CTRL-ENTER} Saves the certificate information on disk.

{ESC} Exits this menu function and returns to the
CERTIFICATE EDITING submenu.

{SHIFT-TAB} Moves the cursor to the previous field.

{TAB} Moves the cursor to the next field.
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Figure 18:  Enter the number to find.

Finding a Record

Before the Find a Record Function can be used, the following actions must have already
been performed:

Opening a file (Creating a New Certificate File pg. 16, or Opening an Existing File
pg. 19).

The file must have certificates in it to be searched.

The Find a Record Function allows the user to find a particular certificate quickly. This is
especially useful when editing certificate data.

1. While the Certificate Information screen is displayed (by using the Edit/Browse
Certificates Function), press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Find a Record Function. Press
{ENTER}.

3. A window (see Figure 18) will be displayed.

4. Type in the certificate number of the desired certificate and press {ENTER}.

A. If the certificate number is in the currently open file, that certificate's data will
be displayed.

B. If the certificate number is not in the currently open file, a message will be
displayed. Press {ENTER}.
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5. The Certificate Information Screen will be re-displayed.
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Super-MICAR 1996: TEST1.DBF
File Edit Process Reports Backup Help

Processed Output (ESC to Exit)

L/T  Entity DUR ERN  

1/1  UNDETERMINED 504 093868

F1-Help 12 52pm

Figure 19:  Cause(s) of death and generated ERNs.

Undoing Changes

Sometimes a change will mistakenly be made to a certificate. These changes can be
undone if the certificate has not been saved yet. (This means that the user hasn't pressed
{CTRL-ENTER}. The Undo Changes Function in the Edit submenu will replace the
displayed certificate with the original data from the certificate file.

1. While the Certificate Information screen is displayed (by using the Edit/Browse
Certificates Function), press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Undo Changes Function. Press
{ENTER}.

3. The Certificate Information Screen will be re-displayed with the most recently
saved data.

Showing Processed Output

In order to use the Show Processed Output Function, the certificate file must first be
processed (see PROCESSING A CERTIFICATE FILE, pg. 42). This Function shows
the ERN codes that were generated for the cause(s) of death listed on the certificate.

1. While the Certificate Information Screen is displayed (by using the Edit/Browse
Certificates Function), press {ALT-P} to select the Process Menu Option.
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2. Use the up and down arrow keys to highlight the Show Processed Output Function.
Press {ENTER}.

3. A window listing the cause(s) of death and the ERNs generated will be displayed
(see Figure 19).

4. When finished viewing the window, press the {ESC} key. The Certificate
Information Screen will be re-displayed.
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DELETING RECORDS

Super-MICAR also offers the ability to delete certificates, either individually or in groups,
from the database. A word of warning: Once a certificate is deleted, IT IS GONE from
Super-MICAR's database. The only way to recover deleted certificates is to restore from
an existing backup of the file. This assumes that a backup exists. See the section Creating
Backups For NCHS (pg. 54) or any of the backup routines in the Super-MICAR System
Manager's Manual for information on backing up and restoring files.

Given below are two ways to delete certificates from Super-MICAR's database. The first
method deletes one certificate at a time. The second can delete any number of certificates
in a database file, up to the highest certificate number entered. Note that {CTRL-Delete}
can be used in conjunction with the Edit/Browse Certificates Function (see Browsing
Through the Certificates, pg. 58).

Deleting Certificates While Editing a Certificate File

The steps below can be used when the Certificate Information Screen (see Figure 7) is
displayed. The steps below allow the user to delete the currently displayed certificate from
the certificate file.

1. Access the Certificate Information Screen for the desired certificate. The
instructions for doing this can be found in the Browsing Through the Certificates
(pg. 58) section of this manual.

2. Press {ALT-E} to select the Edit Menu Option.

3. Use the up and down arrow keys to highlight the Delete Records Function. Press
{ENTER}.

4. A window will be displayed asking to confirm deleting the displayed certificate
data.

A. To delete the certificate from the certificate file, press {Y}. The next certificate
in the file will then be displayed.

B. To abort the deletion, press {N}. The certificate will be re-displayed.

5. The Certificate Information Screen (Figure 7) will be displayed.



Super-MICAR National Center for Health Statistics

Data Processing Manual Page 65

Deleting Several Certificates at Once

If the Delete Records Function is used when the Certificate Information screen (see
Figure 7) is not displayed, the user can delete a group of certificates at once. Note that this
is a sequential deletion - the certificates to be deleted must appear one after another.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Delete Records Function. Press
{ENTER}.

3. A window will be displayed requesting a range of certificate numbers to delete.

4. Use the {TAB} key to move past the last field and begin the sequence check.

5. Type in the certificate number of the last (ending) certificate to be deleted and
press {ENTER}. If the beginning and ending certificate numbers are the same,
only that one certificate will be deleted.

6. Another message will be displayed requesting confirmation to delete the specified
records.

A. To delete the records, type {Y}. A progress bar (Figure 12) will be displayed
showing what percentage of the certificates have been deleted.

B. To abort the deletion, type {N}.

8. A third message will be displayed asking if the user wishes to delete more records.

A. To delete another group of certificates, type {Y} and repeat the steps above.

B. To exit and re-display the main screen, type {N}.
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GENERATING REPORTS

The Functions given below can be used to generate Super-MICAR Reports. The Sequence
Check tells the user if there are any missing certificate numbers. The Generate MICAR100
File Function is described under GENERATING A MICAR100 FILE, pg. 51. Print
Error Listing allows the user to print a compiled list of errors detected during processing.
The Generate Query Letters Function is described in the Super-MICAR System Manager's
Manual.

Generating a Sequence Check

The Sequence Check Function creates a file (named filename.SSQ) containing a report on
missing, extra, duplicate, and out of sequence certificates by certificate number in the
database file. The Sequence Check can be used only when a file is currently open. To use
the sequence check, do the following:

1. From the main screen, press {ALT-R} to select the Reports Menu Option.

2. Use the up and down arrow keys to highlight the Sequence Check Function. Press
{ENTER}.

3. A window will be displayed requesting a beginning certificate number and an
ending certificate number (see Figure 20). Normally, Super-MICAR will have
already filled in the appropriate numbers. If these need to be changed, or the fields
are empty, do the following:

A. Use the {TAB} key to place the cursor in the desired field.

B. Type in either the beginning certificate number (the starting certificate number
for the sequence check) or the ending certificate number (the ending certificate
number for the sequence check).

4. A progress bar (see Figure 12) will be displayed showing the progress of the
sequence check.

5. When the sequence check is completed, a message window will be displayed. Press
any key to continue.
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Figure 20:  The Sequence Check screen.
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Figure 21:  A Print Request window.

6. The output of the sequence check (filename.SSQ) will then be displayed. Use the
up and down arrow keys to scroll through the output (or {PgUp} and {PgDn}).
Press the {ESC} key to close the output window.

7. Next, the computer will beep and a print request window (see Figure 21) will
appear.

A. To print out a copy of the sequence check report, type {Y}. A printing in
progress window will appear. When the printing is finished, the main screen
will be re-displayed.

B. To abort the printing and re-display the main screen, type {N}.
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Printing an Error Listing

The Print Error Listing Function generates a printout of any errors detected during
processing. There must be an open certificate file and the certificates must have already
been processed.

1. From the main screen, press {ALT-R} to select the Reports Menu Option.

2. Use the up and down arrow keys to highlight the Print Error Listing Function and
press {ENTER}.

3. Super-MICAR will attempt to print out an error listing.

A. If Super-MICAR is unable to find a printer, an error message will be displayed.
Press {ENTER} to re-display the main screen.

B. If the printer is located, Super-MICAR will display a "Printing in progress"
message window while the report is being printed.

4. If the report is successfully printed, Super-MICAR will automatically re-display
the main screen.

Printing All the Certificates

Super-MICAR allows the user to print out all of the certificates within a file. These
hardcopy printouts can be used to check for errors as well as any other purposes
determined by the Supervisor.

1. From the main screen, press {ALT-R} to select the Reports Menu Option.

2. Use the up and down arrow keys to highlight the Print All Certificates Function
and press {ENTER}.

3. A message window will be displayed saying, "Printing in progress. Please wait." 
The certificates will be printed.

4. When printing is finished, the main screen will be re-displayed.
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Printing a Single Certificate

Super-MICAR also allows single certificates to be printed. The process for doing this is
described below:

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit/Browse Certificates Function
and press {ENTER}.

3. A Certificate Information Screen (see Figure 7) will be displayed. Use the
instructions under Finding a Record (pg. 60) to find the specific certificate to print
out.

4. With the desired certificate displayed, press {ALT-E} to select the Edit Menu
Option. Alternatively, press {F7} and go directly to step 6.

5. Use the up and down arrow keys to highlight the Print a Record Function and press
{ENTER}.

6. A message window will be displayed saying, "Printing in progress. Please wait." 
The certificates will be printed.

7. When printing is finished, the main screen will be re-displayed.
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EXITING Super-MICAR

There are two ways to exit Super-MICAR. The first, and easiest, is by pressing {ALT-X}
and then pressing {Y}. The second method is described below.

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Exit Super-MICAR Function and
press {ENTER}.

3. A message window will be displayed.

A. To exit Super-MICAR, press {Y}. Super-MICAR will end and the DOS
prompt will be displayed.

B. To abort the exit, press {N}. The main screen will be re-displayed.
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APPENDIX A - NCHS STATE CODES

Code State Abbrev. Code State Abbrev.
01 Alabama AL 28 Nebraska NE
02 Alaska AK 29 Nevada NV
03 Arizona AZ 30 New Hampshire NH
04 Arkansas AR 31 New Jersey NJ
05 California CA 32 New Mexico NM
06 Colorado CO 33 New York NY
07 Connecticut CT 34 North Carolina NC
08 Delaware DE 35 North Dakota ND
09 Dist. Columbia DC 36 Ohio OH
10 Florida FL 37 Oklahoma OK
11 Georgia GA 38 Oregon OR
12 Hawaii HI 39 Pennsylvania PA
13 Idaho ID 40 Rhode Island RI
14 Illinois IL 41 South Carolina SC
15 Indiana IN 42 South Dakota SD
16 Iowa IA 43 Tennessee TN
17 Kansas KS 44 Texas TX
18 Kentucky KY 45 Utah UT
19 Louisiana LA 46 Vermont VT
20 Maine ME 47 Virginia VA
21 Maryland MD 48 Washington WA
22 Massachusetts MA 49 West Virginia WV
23 Michigan MI 50 Wisconsin WI
24 Minnesota MN 51 Wyoming WY
25 Mississippi MS 52 Puerto Rico PR
26 Missouri MO 53 Virgin Islands VI
27 Montana MT 54 Guam GU

55 New York City YC*

* Code 55 is used for occurrence data only. When coding residence data on the demographic
file, code 33 (New York State) must be used.
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APPENDIX B - MENU LISTINGS

Super-MICAR Menu Options

Key Combination        Menu Option Accessed   

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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Super-MICAR Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File
{SHIFT-F7} Export to ASCII File
{SHIFT-F8} Import from ASCII File

Repair File Index
Merge Another File

{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

Set Backup File Path
Set MICAR100 Export Path
DOS Subsession

{ALT-X} Exit Super-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F9} Edit Additional Info
{ALT-O} Edit Industry/Occupation
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{ALT-U} Undo Changes

Process
Mark Misspellings/Illegibles
Correct Misspellings/Illegibles
Process All Records
Process Rejects
Process Additional Info
Generate MICAR100 File

{F6} Show Processed Output
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Reports
Sequence Check
Generate QC Database
Print Error Listing
Print All Certificates
Generate Query Letters

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove

Help
{F1} View Help File
{ALT-F1} About Super-MICAR
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APPENDIX C - DICTIONARY OF TERMS USED

Since not everyone will be familiar with the terms used in these instructions, here is a brief
glossary of some of the words.

Certificate File - A file containing certificate data. This term is used interchangeably
with Database File.

Data Directory - A subdirectory on the computer where Super-MICAR certificate
files are stored. By default, the data directory is a subdirectory of
the <SUPMICAR> directory called <DATA>. The default value
can be changed through Super-MICAR.

Database File - A file containing certificate data. This term is used interchangeably
with Certificate File.

Directory - A specific grouping of files on a disk. Also referred to as a
subdirectory. The directory that will be used most with Super-
MICAR will be the <SUPMICAR> directory.

DOS - A Disk Operating System. The System Manager will handle most
operations that deal with DOS. The only time the data entry
personnel will use DOS will be in the STARTING Super-MICAR
section of this manual.

Export - To take data from the Super-MICAR certificate database and place
it in a formatted file that is readable by other programs.

Extension - A 3-letter identifier at the end of a filename that identifies what type
of file it is. For example: .EXE is an executable file, .DBF is a
database file, and so forth.

Filename - The name of a file on a disk. Example: SUPMICAR.EXE is made
up of the filename SUPMICAR and extension .EXE.

Hotkey - A key or pair of keys that can be pressed to access a menu function
directly, without going through the menu system. For example,
pressing the F2 key will access the Open a File menu option.
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Import - To read data from a formatted file and place it in a Super-MICAR
certificate database. 

Menu - A list from which an action can be selected for Super-MICAR to
perform. Super-MICAR has both a main menu and submenus. The
main menu appears as a bar across the top of the screen, just below
the program name. From the main menu, a submenu can be
displayed listing actions to be performed. See the section Using the
Super-MICAR Menu System (pg. 13) for more details on how to
use the menu.

Pick List - A list of items that can be selected (picked) by using the up and
down arrow keys to highlight the desired item and then pressing
{ENTER}.

Subdirectory - See Directory above.

Submenu - A group of related actions arranged into a list from which an action
can be selected. Submenus are available through the main menu.
See the section Using the Super-MICAR Menu System (pg. 13)
for more information on the menu system.

Table - A subdirectory on the computer where Super-MICAR processing
Directory files are stored. By default, the table directory is a subdirectory of

the <SUPMICAR> directory called <TABLES>. The default value
can be changed through Super-MICAR.
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APPENDIX D - CONVENTIONS USED IN THIS MANUAL

As a rule, any commands that need to be entered while the user is in Super-MICAR will
be given in the following format:

1. All of the actual typing and keys that need to be pressed will be given in all-caps
(Example: type DIR and press {ENTER} to get a list of files in a directory).

2. Any information that the user needs to provide, such as filenames, will be
requested in brackets (Example: type [filename.ext] means that the user needs to
type in the filename and its extension, like so: type WY91001.DBF, without the
brackets.)

3. When the word "press" appears in front of a word in all-caps, the user needs to
press and release a particular key (Example: press {ESC} means press and release
the ESC key). Also, the names of all keys will be given in braces {}.

4. Whenever two keys are named with a hyphen ( - ) connecting them, both keys are
to be pressed at the same time to perform the listed function (Example:
{CTRL-ENTER} = press and hold the {CTRL} and {ENTER} keys at the same
time).

5. At times, references will be made to other Menu Options or Functions of
Super-MICAR. The following standards will be used in these cases:

A. Any selection from the Main Menu (the menu that runs across the top of the
Super-MICAR screen, just below the title) will be called a Menu Option
(Example: the File Menu Option).

B. Any selection from a submenu will be called a menu Function or just Function
(Example: the Edit/Browse Certificates Function).

6. All directory names will be marked by greater than and less than symbols
(Example: The directory containing the Super-MICAR programs is the
<SUPMICAR> directory).
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APPENDIX E - SPECIAL SYMBOLS

Following is a list of symbols and their meanings commonly used on the Cause of Death
sections of a death certificate. This list is for use with Adding Certificates, pg. 21, 30.

# "Fracture." Substitute for the word "fracture." Example: For "Leg #," type "LEG
FRACTURE".

"Decreased." Substitute for the word "decreased." Example: For "  blood
pressure," type "DECREASED BLOOD PRESSURE".

"Increased." Substitute for the word "increased." Example: For "  hemorrhaging,"
type "INCREASED HEMORRHAGING".

o o
I "Hour." Substitute for the word "Hour." Example: For "1 I," type "1 HOUR".

oo
II "Secondary to." Substitute for the words "secondary to." Example: For

oo
"Pneumonia II Gunshot wound," type "PNEUMONIA SECONDARY TO
GUNSHOT WOUND".

1 "Primary." Substitute for the word "primary." Example: For "1  colon cancer,"
type "PRIMARY COLON CANCER".

2 "Secondary to." Substitute for the words "secondary to." Example: For "Pneumonia
2  cardiorespiratory infection," type "PNEUMONIA SECONDARY TO
CARDIORESPIRATORY INFECTION".

c "With." Substitute for the word "with." Example: For "Heat stroke c myocardial
_ _

infarction," type "HEAT STROKE WITH MYOCARDIAL INFARCTION".

p "After." Substitute for the word "after." Example: For "Spontaneous bleeding p
_ _

tracheal tube removal," type "SPONTANEOUS BLEEDING AFTER TRACHEAL
TUBE REMOVAL".

s "Without." Substitute for the word "without." Example: For "Three weeks s taking
_ _

medication," type "THREE WEEKS WITHOUT TAKING MEDICATION".

w/ "With." Substitute for the word "with." Example: For "Heat stroke w/ myocardial
infarction," type "HEAT STROKE WITH MYOCARDIAL INFARCTION".
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APPENDIX F - PROCESSING REJECTED RECORDS

Super-MICAR may reject a record for any of several reasons.  A word may be misspelled,
two separate terms may be listed on a single line with no punctuation between them, or an
external cause may be embedded in the record, just to name a few.  Unlike ACME, Super-
MICAR does not generate messages  corresponding to the reason for processing failure. 
This section provides some general instructions for correcting Super-MICAR records
during processing.

Two Terms on a Line

If two separate terms appear on a single line with no divider to separate them (a divider
can be a punctuation mark or any of several words that indicate a division, such as AND
or WITH), they may be processed as a single term and thus produce an error.  In this case,
place a semicolon (;) between the two terms and save the certificate.  This will solve most
cases of this variety.

Example: II. DIABETES MELLITUS END STAGE RENAL DISEASE
enter: DIABETES MELLITUS; END STAGE RENAL DISEASE;

Misspelling/Unrecognized Terms, Extraneous Information

If a misspelled or unknown term appears in a record, simply type over the old term to give
the certificate the correct spelling for the term.  In other cases, a word appears that has no
significance to a death certificate, such as a person's name or the name of a hospital or
city.  In these cases, access the Additional Information (AI) screen and delete the
unnecessary information.  Super-MICAR will process the AI information instead of the
original certificate data.

Example: Ib. ARTERIOSCLEROTIC HRT DX
enter: ARTERIOSCLEROTIC HEART DISEASE  or ASHD

Dates and Times

Under most circumstances, Super-MICAR will automatically pull dates and times from a
line and will, under certain circumstances, use them to generate a proper duration for the
term.  But because dates and times can be written in so many ways, Super-MICAR will
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sometimes miss a date or time. If this occurs, access the additional information screen for
the certificate and remove the date or time from the line. If appropriate, use the deleted
date to supply a duration code for the term (if one is not already provided).

Example: II. DIED 25 DAYS AFTER MITRAL REPAIR AND CORONARY
BYPASS SURGERY

enter: MITRAL REPAIR; CORONARY BYPASS SURGERY 

Example: Ib. ESSENTIAL HYPERTENSION 4 YRS
enter: ESSENTIAL HYPERTENSION and in DURATION block: 4 YRS

External Causes

If Super-MICAR encounters an external cause that it cannot interpret, it applies the codes
EXTERN to the term and rejects it.  (The EXTERN code appears on the Processed Entries
screen.)  Proper use of the External Cause Prompts require training in MICAR data entry. 
If this training has not been completed, DO NOT use the external prompts.  The record
will be rejected for manual multiple cause coding.  If the user is certified in MICAR data
entry, access the Additional Information screen for the certificate and use the external
cause prompts to generate a code that indicates the external cause.  (See Processing
Rejects for information on the external cause prompts.)

Multi-Line Terms

Many certificates contain terms that flow from one line to the next.  Super-MICAR makes
an attempt to identify these terms and bring them together, but sometimes it fails to
recognize the condition.  In that case, access the Additional Information screen for the
certificate, position the cursor on the line that should be connected with the previous line,
and press ALT-D to delete the line number for that line, indicating that the two lines
should be considered as one for the purpose of processing it.

Two Lines Flowed Together

Because Super-MICAR attempts to flow lines together, it will from time to time flow two
lines together that should be left separate.  This often occurs when a line is improperly
formatted, perhaps ending with a modifier that should be applied to a prior lead term.  In
these cases, access the Additional Information screen and re-format the first line, putting
modifiers prior to the terms that they modify.  Another condition that may cause lines to
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be run together improperly occurs when the last character on a line is a punctuation mark,
such as a comma, semicolon, or period.  To correct errors of this variety, simply remove
the punctuation mark. (This often occurs when periods are used to divide the letters in an
abbreviated term, such as C.O.P.D. The periods are not necessary and can all be deleted.)
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